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--- mmmmmmmmmememeeeee ABSTRACT --- --- ---
This study focused on assessing spatial activities around the Tamale Main Slaughterhouse in Ghana using ArcMap
software. By employing geospatial analysis techniques, the research aims to provide insights into the distribution and
intensity of various activities near the abattoir, including commercial, residential, and infrastructural elements.

The study utilized ArcMap, a widely adopted Geographic Information System (GIS) software, to collect,
process, and analyze spatial data. Primary data were gathered through field surveys, including interviews and
observations, to obtain accurate information on land uses and activities. Satellite imagery and aerial photographs were
also incorporated to enhance the spatial analysis.

The research employed several spatial analysis techniques, such as proximity analysis, density mapping, and
hotspot analysis, to assess the spatial patterns and relationships between the abattoir and its surrounding areas.

The spatial analysis identified potential issues such as the encroachment of residential areas into the abattoir
vicinity or the presence of critical infrastructure in close proximity to the slaughterhouse. The manure and the blood
from the slaughterhouse have been good by-products for the production of poultry feed in a form of maggot. A big
dugout should be made to channel the cow dung, blood and other waste products into it and covered to prevent the
pollution of boreholes around the area.
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INTRODUCTION

Abattoirs, also known as slaughterhouses, play a crucial role in the meat industry by providing a controlled
environment for the processing and preparation of meat products. However, the spatial activities surrounding abattoirs
can have significant implications for public health, environmental quality, and community well-being (1).

The spatial activities surrounding abattoirs encompass various factors, including transportation routes, waste
management practices, land use patterns, and proximity to residential areas. These activities can give rise to potential
hazards such as noise pollution, odors, traffic congestion, and contamination risks(2)(3) (4) (5). The waste generated
by the abattoir has negative effect on the quality of water in the boreholes around the abattoir (6)(7) (8) (9).
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The Ghana Food and Drugs Authority (FDA) describes an abattoir as a facility/ place that is approved and registered
for slaughtering and dressing of animals for human consumption (FDA/APBD/CP-SH/2013/08). The FDA further
requires any facility being used as an abattoir should have equipment for slaughtering, holding, processing, storing
and distributing the carcass.

Description of the Public Health Problem

The FDA guideline FDA/APBD/CP-SH/2013/08 is one of many guidelines, laws and regulations for the operation of

slaughter houses in Ghana. These regulations provide the criteria for maintaining minimum standards at the abattoirs

based upon which the abattoirs will be inspected and certified. These minimum standards cover the following:
1. Sanitary conditions of the abattoir State and nature of infrastructure to include but not limited to equipment,
source of water and the regularity of supply, the drainage system in place and how effluent is discharged.
2. Personnel — health certification and neatness of uniform. In addition, the manager or assistant should have
been trained in a formal institution on food safety
3. Type, state and availability of storage and transportation facilities of the abattoir

No human activity should occur at least 300meters around the abattoir

Waste water drainage canal outside the slaughterhouse building to the waste water facility shall be covered

with detachable concrete cover and this has not been the case of Tamale abattoir.

6. Ideally the slaughterhouse should be located away from residential areas to prevent possible inconvenience
to dwelling-places either by way of pollution from slaughter wastes or by way of nuisance from noise (FAQO,
1985).

The purpose of this study was to develop geographic information system, create a buffer zone of 300meters around

the abattoir and tease out the public health significance of its spatial data in and around Tamale abattoir (10).

o~

Description of the Study Area

Tamale abattoir is located in Sagnarigu Municipal within South Eastern part of Shishagu, along Tamale Nyankpala
road. Tamale abattoir started operations on 30th September, 2005 and has a total land area of about 14000m?. It is
about 3 km from Tamale main township. According the leadership of the abattoir, 1t has a staff capacity of 16, that is,
6 assembly staff made up of the officer in charge and his deputy, 2 veterinary officers with 2 revenue collectors and
10 laborers’. The butchers number well over a hundred and are not considered as staff.

MATERIALS AND METHODS

Description of Field Instruments and Equipment

This study employed a multi-step methodology, starting with data collection on the abattoir's location, surrounding
land use, transportation infrastructure, waste management practices, and relevant demographic information.
Geospatial datasets were collected from reliable sources, including government agencies, open data repositories, and
field surveys. The collected data were then processed and integrated within the Arc Map software to create a
comprehensive spatial database.

An android phone with an installed maps.me was used to collect the coordinate of the spatial data. These respective
coordinates were carefully written in a note book and keyed into Microsoft excel.

ArcMap allows users to perform sophisticated spatial analyses that help in understanding patterns, relationships, and
trends in geographic data. In an abattoir context, this could involve analyzing the distribution of different processing
areas, waste disposal points, equipment placement, and more. These analyses can provide insights into workflow
optimization, resource allocation, and potential bottlenecks.

ArcMap GIS offers a powerful set of tools for assessing spatial activities in an abattoir, enabling better planning,
management, and decision-making to enhance efficiency, safety, and regulatory compliance within the facility.
Abattoirs can have significant environmental impacts, including waste generation, water consumption, and pollution

(11) (12) (13).

ArcMap can help assess and visualize these impacts by integrating various environmental data, such as land use, water
bodies, and air quality, to identify potential areas of concern and implement mitigation measures.
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Field procedures used in collecting the data

This involves using maps.me application that gives you the location, then click on the arrow to obtain the latitude and
longitude. This is done for all spatial data to obtain the latitude and longitudes of the various coordinates and ensure

proper documentation.

Description of procedures of data processing
Arc map GIS was used to process the data, which involves the following:

» Coordinates were keyed into Microsoft excel and a folder created which was then stored in drive C of the

computer.
» Left click add on the ArcMap on the standard tool bar

» Navigate to the folder where you saved your shapefile from the DNR Garmin software and it.

» Left click on Add and your shapefile will be opened

Projection of data

Left Click on the ARC tool bar icon

Left Click on data management tool

Left Click on projections and transformation
Left Click on feature

Double click on project

Select sheet & events

Left Click on output coordinate system

Left Click on projected coordinate system
Left Click on UTM

Left WGS 1984

Left click Northern hemisphere

Left click on 30N without complex

Left click on ok

A display of hammer with correct mark sign will launch

VVVVVVVVVYVYVVYYY

Creating a buffer of 300meters around the main abattoir
Select the main abattoir using the select arrow

Left Click on the ARC tool bar icon

Left click on data management tools

Left click on proximity

Double click buffer

Select the input and out

And then click on ok

A display of hammer with correct mark sign will launch

VVVVVVYVYY

Insert scale, north arrow, legend and title
In the Insert Menu:
» Click on North Arrow
»  Choose the appropriate north arrow
»  Click Ok.
The same procedure can be repeated for legend, scale and title

Adding of base map
» Left click on add icon on the standard tool bar
» Left click on imagery with labels

» Adisplay of imagery will pop up after some minutes depending on the network.

Saving your Map Project
» Save the ArcMap project together with the data in the same folder.
» Give title

---- € 2023 EPRA EGEI | https://eprajournals.com/ | Journal DOl URL: https://doi.org/10.36713/epra0713 --------- 9



https://eprajournals.com/

EPRA International Journal of Economic Growth and Environmental Issues- peer Reviewed Journal
ISSN: 2321-6247
Volume: 11 | Issue: 11 | December 2023 | Journal DOI: 10.36713/epra0713 | SJIF Impact Factor (2023): 8.322

> Click on the File Menu and choose Save As

Description of Plotting Processing

Right click on sheet 2

Click display XY data

Specify the field for X, Y and Z

Edit the coordinate system by clicking on world and then select world 1984
Click ok and your coordinates will be plotted

VVVVYYV

Ethical consideration

An introductory letter was sent to Sagnarigu Municipality, through the leadership of the abattoir seeking their consent
for the study. The purpose of the study was explained to them in the letter and permission was granted for the study.
Ethical procedures for conducting research were strictly adhered during this study.

RESULTS

From figure 1 below, it can be realized that a lot of houses and stores fell in to the buffer zone of 300meters. The
residents of these houses are at risk of being exposed to animal related disease including: Anthrax, Brucellosis,
Escherichia coli, Q-fever (Query fever) etc. human activities in these buffer zone can temper with the quality of the
meat produce.

At the Eastern part of the slaughter house just after the fence wall the waste that leaves the premises pollute the wells
of that zone though enough land is available but waste get into the well through the soil which has reduce the quality
of the water.

The disposal of waste products from the abattoir leaves much to be desired and hence a call for public health
emergency. A small gutter has been created where these waste passes through and is connected to a stream where it
empties its content. To facilitate the drainage of the waste they usually drain the cow dung to allow the water mixed
with blood to drain out. The scent coming from the gutter that empty its content at the stream is a major complain to
the residence around the facility.

A novelty finding in this work was that, farmers could gather the cow dung from the slaughtered animals with blood
at one place and cover it with grass. Within two (2) to three (3) days, it breeds countless maggot which is used to feed
poultry. This feed is good for the poultry. There is a well outside the abattoir wall, at the point where the gutter meets
the stream which supplies water to most of the residence within the area, however the people complained that the
moment it rains the colour, taste and scent of the water changes to the that of cow dung which reduces the quality of
the water.
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BUFFER ZONE OF ABATTOR

’Hﬂu *

Figure 1: Spatial Activities Around Tamale Main Abattoir
DISCUSSION
The assessment of spatial activities around abattoirs using Arc Map software provided valuable insights into the
distribution and potential impacts of various factors related to abattoir operations. The findings shed light on the spatial
relationships between abattoirs and surrounding land use, transportation networks, waste management practices, and
proximity to sensitive receptors. This discussion presents an overview of the key results obtained through the analysis
and their implications.

The analysis of land use patterns revealed the spatial distribution of different land uses around abattoirs. The results
indicated that industrial and agricultural zones were the most prevalent land use types in close proximity to abattoirs
(14). This concentration of compatible land uses suggests that abattoirs are often located in areas designated for
industrial or agricultural activities. However, it is important to note that the presence of other land uses, such as
residential areas or sensitive environmental areas, in close proximity to abattoirs may pose potential health risk of
microbial infection (15)(16).

A buffer of 300meters around the main abattoir indicates a lot of human activities going on including residence, market
and mosque built just by the wall of the abattoir. These contravene the standard set by Food Drug Authority that says
that there should not be any human activity at least 300 meters. In addition, the manner in which the by products
including: cow dung, blood and other liquid waste are dispose is a great concern to people leaving around the abattoir
similar to the findings of Okpala. (17). The implication is that there is poor sanitation in the facility that would lead to
people contracting diseaseas.
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The spatial analysis of waste management practices around abattoirs highlighted the distribution of waste disposal
facilities and potential sources of environmental impact similar to the findings of Yunus. (18) and Olowoporoku.,
(19). The results indicated that the abattoir did not have designated places for designated waste disposal areas, such
as waste water treatment plants or solid waste management facilities, in close proximity contrary to the work of (1)
(where dissonated places are made available for waste disposal. However, the analysis also identified areas where
waste management infrastructure may be inadequate, leading to potential environmental risks. This finding
underscores the importance of robust waste management practices and the need for regular monitoring and
enforcement to minimize environmental pollution (20).

The assessment of proximity to sensitive receptors, such as residential areas, schools, and water bodies, provided
valuable insights into potential exposure risks and the need for adequate safeguards. The results revealed that a
significant number of houses were located in close proximity to abattoir. This proximity raises concerns regarding
potential odor nuisances, noise pollution, and potential health impacts on nearby residents similar to the findings of
(21). It emphasizes the importance of implementing appropriate buffer zones and mitigation measures to protect
sensitive receptors from potential adverse effects.

Strength of the Facility

Tamale abattoir has been well built with a fence wall to improve the quality of meat production through the
performances of hygienic practice and to prevent the encroachment of people. The toilet facility has been well built
since a buffer of 60 meters does not cover any other human activity. The cow dung that has been generated by the
abattoir has been used for different purposes including: manure and the use of fresh cow dung to breed maggot to feed
poultry, which is very good for the growth of the poultry.

CONCLUSION

In conclusion, the use of ArcMap software to assess spatial activities around the Tamale main Abattoir has provided
valuable insights and information for understanding the dynamics of this critical urban area. This study has
demonstrated the importance of employing Geographic Information Systems (GIS) technology in urban planning and
management, especially in relation to facilities like abattoirs.

Through the analysis of spatial data, we have gained a comprehensive understanding of the geographical distribution
of activities around the abattoir. This information can inform decision-makers, local authorities, and urban planners
in implementing more effective and sustainable strategies for urban development, environmental management, and
public health.

The study has shown that the Tamale main Abattoir is in close proximity to residential areas, which raises concerns
about potential environmental and health impacts on the local population. This information underscores the need for
careful urban planning and zoning regulations to ensure the safety and well-being of the community.

Spatial data has allowed us to assess the environmental impact of the abattoir on nearby water bodies, land use, and
vegetation. This information is instrumental in formulating strategies for sustainable development and ensuring
responsible waste disposal and water resource management.

Understanding the spatial distribution of markets, hospitals, and schools around the abattoir is vital for assessing
potential public health risks. This knowledge can guide the implementation of health and safety measures to protect
the well-being of both workers and the local community.

RECOMMENDATIONS

The blood from slaughtered animals will coagulate into a solid mass, which may block up both open and closed drains.
It is therefore recommended that the blood is collected and used for human consumption. Local government should
monitor the construction of abattoir to ensure: the provision of drains with vertical sieves, A dug out can also be made
to collect the cow dung like manhole for human excreta; this will prevent it from polluting the wells and our streams,
routine spraying of the abattoir to prevent possible infestation and re-location of residents within the buffer of
300meters.
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GPS LATITUDE LONGITUDE FEATURE TYPE
1 9.409809 -0.88068 STORE BUILDING
2 9.404164 -0.8852 MOSQUE BUILDING
3 9.407521 -0.89015 VETEX WALL
4 9.404164 -0.8872 HSE RESIDENCE
5 9.408536 -0.88345 TOILET FACILITY BUILDING
6 9.409736 -0.88632 MOSQUE BUILDING
7 9.404164 -0.8852 HSE RESIDENCE
8 9.410536 -0.88235 VETEX WALL
9 9.408094 -0.88974 HSE RESIDENCE
10 9.404164 -0.8852 HSE RESIDENCE
11 9.404094 -0.88566 VETEX WALL
12 9.403968 -0.88595 HSE RESIDENCE
13 9.404164 -0.8852 HSE RESIDENCE
14 9.405461 -0.88949 DUST BIN CONTAINER
15 9.404033 -0.88456 MOSQUE BUILDING
16 9.408983 -0.88974 HSE BUILDING
17 9.404164 -0.8841 HSE RESIDENCE
18 9.40508 -0.88644 MAIN ABBATOIR BUILDING
19 9.405013 -0.87989 HSE RESIDENCE
20 9.40608 -0.88655 LEIRAGE BUILDING
21 9.407996 -0.87789 VETEX WALL
22 9.404162 -0.88954 HSE RESIDENCE
23 9.404024 -0.88566 HSE BUILDING
24 9.404164 -0.8852 MARKET CONTAINERS
26 9.404016 -0.88934 MEET SELLERS UNDER TREES
27 9.404164 -0.8852 STORES CONTAINER
28 9.404164 -0.8852 STORES CONTAINER
29 9.40295 -0.88698 HSE BUILDING
30 9.408764 -0.87868 WELL WATER
31 9.408095 -0.88712 MANGO TREE
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